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Chapter 1

VCU1287 IBERT Getting Started Guide

Overview

This document describes setting up the Virtex UltraScale FPGA VCU1287 GTH and GTY
Transceiver Characterization Board to run the Integrated Bit Error Ratio Test (IBERT)
demonstration using the Vivado® Design Suite. The designs required to run the IBERT
demonstration are stored in a Secure Digital (SD) memory card that is provided with the
VCU1287 board. The demonstration shows the capabilities of the Virtex UltraScale
XCVUO095-FFVB2104 FPGA GTH and GTY transceiver.

The VCU1287 board is described in detail in the VCU1287 Board User Guide (UG1120)
[Ref 1].

The IBERT demonstrations in this guide operate one GTH Quad and one GTY QUAD. The
procedure consists of:

Setting Up the VCU1287 Board, page 6
Extracting the Project Files, page 7
Connecting the GTH Transceivers and Reference Clocks, page 8

Starting the SuperClock-2 Module, page 13

1.

2.

3

4

5. Configuring the FPGA, page 16
6. Setting Up the Vivado Design Suite, page 18

7. Viewing GTH Transceiver Operation, page 24

8. Closing the IBERT Demonstration, page 25

9. Connecting the GTY Transceivers and Reference Clocks, page 26
10. Starting the SuperClock-2 Module, page 28

11. Configuring the FPGA, page 29

12. Setting Up the Vivado Design Suite, page 31

13. Viewing GTY Transceiver Operation, page 36

14. Closing the IBERT Demonstration, page 37
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Requirements

The hardware and software required to run the GTH and GTY IBERT demonstrations are:

* Virtex UltraScale FPGA VCU1287 GTH and GTY transceiver characterization board,
including:

- One SD card containing the IBERT demonstration designs
- One Samtec Bulls Eye™ cable
- Eight SMA female-to-female (F-F) adapters
o Six 50Q SMA terminators
o UltraScale transceiver power supply module (installed onboard)
o SuperClock-2 module, Rev 1.0 (installed onboard)
- Active BGA heat sink (installed on FPGA)
o 12V DC power adapter
o Two USB cables, standard-A plug to micro-B plug
+ Host PC with:
o SD card reader
o USB ports
« Xilinx® Vivado Design Suite 2016.4

The hardware and software required to rebuild the IBERT demonstration designs are:

« Xilinx Vivado Design Suite 2016.4

« PC with a version of the Windows operating system supported by Xilinx Vivado Design
Suite
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Setting Up the VCU1287 Board

This section describes how to set up the VCU1287 board.

& CAUTION! The VCU1287 board can be damaged by electrostatic discharge (ESD). Follow
standard ESD prevention measures when handling the board, such as using a grounding
strap and static dissipative mat.

When the VCU1287 board ships from the factory, it is configured for the support of both
GTH and GTY IBERT demonstrations described in this document. If the board has been
re-configured, it must be returned to the default setup before running the IBERT
demonstrations.

1. Move all jumpers and switches to their default positions. The default jumper and switch
positions are listed in the VCU1287 Characterization Board User Guide (UG1121) [Ref 1].

2. Install the UltraScale transceiver power module by plugging it into connectors J124-J46
and J138.

3. Install the SuperClock-2 module:

a. Align the three metal standoffs on the bottom side of the module with the three
mounting holes in the SUPERCLOCK-2 MODULE interface of the VCU1287 board.

b. Using three 4-40 x 0.25 inch screws, firmly screw down the module from the bottom
of the VCU1287 board.

c. On the SuperClock-2 module, place a jumper across pins 2-3 (2V5) of the CONTROL
VOLTAGE header, J18, and place another jumper across Si570 INH header J11.

d. Screw down a 50QQ SMA terminator onto each of the six unused Si5368 clock output
SMA connectors: J7, )8, J12, J15, J16, and J17.
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Extracting the Project Files

The Vivado Design Suite BIT files required to run the IBERT demonstrations are located in
rdf0368-vcul287-ibert-2016-4.zip on the SD card provided with the VCU1287
board. The BIT files are also available online at the Virtex UltraScale FPGA VCU1287
Characterization Kit documentation website.

The ZIP file contains these BIT files:

e vcul287_ibert_ql24_125.bit
« vcul287_ibert_ql25_125.bit
e vcul287_ibert_ql26_125.bit
« vcul287_ibert_ql27_125.bit
e vcul287_ibert_ql28_125.bit
e vcul287_ibert_ql29_125.bit
e vcul287_ibert_ql30_125.bit
e vcul287_ibert_ql31_125.bit
e vcul287_ibert_q224_125.bit
« vcul287_ibert_q225_125.bit
e vcul287_ibert_q226_125.bit
« vcul287_ibert_q227_125.bit
e vcul287_ibert_q228_125.bit
« vcul287_ibert_q229_125.bit
e vcul287_ibert_q230_125.bit
e vcul287_ibert_q231_125.bit

To copy the files from the SD card:

1. Connect the SD card to the host computer.
2. Locate the file rdf0368-vcul287-ibert-2016-4.zip on the SD card.

3. Unzip the files to a working directory on the host computer.
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Running the GTH IBERT Demonstration

The GTH IBERT demonstration operates one GTH Quad at a time. This section describes how
to test GTH Quad 224. The remaining GTH Quads can be tested following a similar series of
steps.

Connecting the GTH Transceivers and Reference Clocks
Figure 1-1 shows the locations for GTH and GTY transceiver Quads on the VCU1287 board.

Figure 1-1 is for reference only and might not reflect the current revision of the board.

Note: Quads 133, 232, and 233 are not available on the XCVU095 device.

auan_ zzy

OuAD_777

auan_ z2xl

w0735 § OUAD 7R ouaD 124 FGEL
S e

UltraSCALE ™
X15535-121416

Figure 1-1: VCU1287 GTH and GTY Quad Locations

VCU1287 IBERT Getting Started Guide N Send Feedback 8
UG1203 (v2016.4) December 15. 2016 www.xilinx.com l—\/—l



https://www.xilinx.com
http://www.xilinx.com/about/feedback.html?docType=User_Guides&docId=UG1203&Title=Virtex%20UltraScale%20FPGA%20VCU1287%20Characterization%20Kit%20IBERT&releaseVersion=2016.4&docPage=8

8 XI I_I NX Chapter 1: VCU1287 IBERT Getting Started Guide

ALL PROGRAMMABLE-

All multi-gigabit transceiver (MGT) pins and reference clock pins are routed from the FPGA
to a connector pad that interfaces with Samtec Bulls Eye connectors. Figure 1-2 A shows the
connector pad. Figure 1-2 B shows the connector pinout.

MGT Connector Pad MGT Connector Pinout

X15541-121416
Figure 1-2: A—MGT Connector Pad. B—MGT Connector Pinout

The SuperClock-2 module provides LVDS clock outputs for the MGT transceiver reference
clocks in the IBERT demonstrations. Figure 1-3 shows the locations of the differential clock
SMA connectors on the clock module which can be connected to the reference clock cables.

CLKOUT4 P

SI570_CLK N

X15542-121416
Figure 1-3: SuperClock-2 Module Output Clock SMA Locations

The four SMA pairs labeled CLKOUT provide LVDS clock outputs from the Si5368 clock
multiplier/jitter attenuator device on the clock module. The SMA pair labeled Si570_CLK
provides LVDS clock output from the Si570 programmable oscillator on the clock module.

Note: The Si570 oscillator does not support LVDS output on the Rev B and earlier revisions of the
SuperClock-2 module.

For more information on the SuperClock-2 module, see the HW-CLK-101-SCLK2
SuperClock-2 Module User Guide (UG770) [Ref 2].
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Attach the GTH Quad Connector

Before connecting the Bulls Eye cable assembly to the board, firmly secure the blue

elastomer seal provided with the cable assembly to the bottom of the connector housing if
it is not already inserted (see Figure 1-4).

Note: Figure 1-4 is for reference only and might not reflect the current version of the connector.

X15543-121416
Figure 1-4: Bulls Eye Connector with Elastomer Seal

Attach the Samtec Bulls Eye connector to GTH Quad 224 (Figure 1-5), aligning the two
indexing pins on the bottom of the connector with the guide holes on the board. Hold the
connector flush with the board and fasten it by tightening the two captive screws.

X15544-121416

Figure 1-5: Bulls Eye Connector Attached to Quad 224

VCU1287 IBERT Getting Started Guide

. l Send Feedback l 10
UG1203 (v2016.4) December 15. 2016 www.xilinx.com



https://www.xilinx.com
http://www.xilinx.com/about/feedback.html?docType=User_Guides&docId=UG1203&Title=Virtex%20UltraScale%20FPGA%20VCU1287%20Characterization%20Kit%20IBERT&releaseVersion=2016.4&docPage=10

i: XI I_INX Chapter 1: VCU1287 IBERT Getting Started Guide

ALL PROGRAMMABLE

GTH Transceiver Clock Connections

See Figure 1-2 to identify the P and N coax cables that are connected to the CLKO reference
clock inputs. Connect these cables to the SuperClock-2 module as follows:

* CLKO_P coax cable — SMA connector J7 (CLKOUT1_P) on the SuperClock-2 module
e CLKO_N coax cable — SMA connector J8 (CLKOUT1_N) on the SuperClock-2 module

Note: Any one of the five differential outputs from the SuperClock-2 module can be used to source
the GTH reference clock. CLKOUT1_P and CLKOUTL_N are used here as an example.

MGT TX/RX Loopback Connections

See Figure 1-2 to identify the P and N coax cables that are connected to the four receivers
(RX0, RX1, RX2, and RX3) and the four transmitters (TX0, TX1, TX2, and TX3). Use eight SMA
female-to-female (F-F) adapters (Figure 1-6) to connect the transmit and receive cables as
shown in Figure 1-7:

« TXO0_P — SMA F-F Adapter —» RX0_P
« TXO_N — SMA F-F Adapter - RXO_N
« TX1_P — SMA F-F Adapter —» RX1_P
« TX1_N — SMA F-F Adapter - RX1_N
« TX2_P — SMA F-F Adapter —» RX2_P
« TX2_N — SMA F-F Adapter - RX2_N
« TX3_P — SMA F-F Adapter —» RX3_P
« TX3_N — SMA F-F Adapter — RX3_N

Note: To ensure good connectivity, it is recommended that the adapters be secured with a wrench;
however, do not over-tighten the SMAs.

3 it

X15545-121416

Figure 1-6: SMA F-F Adapter
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TX Coax

SMA F-F Adapter

/—F{X Coax ; 3

L

X15546-121416

Figure 1-7: TX-to-RX Loopback Connection Example

Figure 1-8 shows the VCU1287 board with the cable connections required for the Quad 224
GTH IBERT demonstration.

@
=4
3
4
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b1 1
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b
pi
&
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- E
UltraSCALE

X15547-121416

Figure 1-8: Cable Connections for Quad 224 GTH IBERT Demonstration
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Starting the SuperClock-2 Module
The SuperClock-2 module features two clock-source components:

« Always-on Si570 crystal oscillator

« Si5368 jitter-attenuating clock multiplier
Outputs from either source can be used to drive the transceiver reference clocks.
To start the SuperClock-2 module:

1. The SuperClock-2 module is configured using the Xilinx XC7Z010CLG225
Zyng-7000APSoC System Controller command line which can be accessed through a
serial communication terminal connection using the enhanced communication port of
the Silicon Labs USB to Dual UART Bridge (Figure 1-9). Additional information about the
Silicon Labs USB-to-UART is available in Silicon Labs CP210x USB-to-UART Installation
Guide (UG1033) [Ref 3].

Review the VCU1287 Evaluation Board User Guide (UG1120) [Ref 1] for additional
information about the System Controller.

4 ? Ports (COM 8 LPT)

I ? Communications Port

--‘?’ Intel(R) Active Management Technology - 50L

b ISlIlcu:ur'l Labs Dual CP210x USE to UART Bridge: Enhanced COM F'u:urtl
------ ?' Silicon Labs Dual CP210x USE to UART Bridge: Standard COM Port

X15548-121416

Figure 1-9: Silicon Labs Enhanced COM PORT

2. Set the System Controller configuration DIP switches (SW13) to the OFF position
(Figure 1-10). This disables configuration of the FPGA at power reset.

ON

ENABLE
ADDRO
ADDR1
ADDR?2
ADDR3

T

X15549-121416

Figure 1-10: Configuration DIP Switch (SW13)

VCU1287 IBERT Getting Started Guide N Send Feedback 13
UG1203 (v2016.4) December 15. 2016 www.xilinx.com [—\/—]



https://www.xilinx.com
http://www.xilinx.com/about/feedback.html?docType=User_Guides&docId=UG1203&Title=Virtex%20UltraScale%20FPGA%20VCU1287%20Characterization%20Kit%20IBERT&releaseVersion=2016.4&docPage=13

8 XI I_I NX Chapter 1: VCU1287 IBERT Getting Started Guide

ALL PROGRAMMABLE-~

3. Connect J1 connector (USB/UART) on the VCU1287 board to the host computer using
one of the standard-A plug to micro-B plug USB cables provided (Figure 1-11) and
power up the board by placing SW1 in the ON position.

X15550-121416

Figure 1-11: USB-UART Connector

4. Open a serial communication terminal application on the host computer, for example
“HyperTerminal”, and connect to the port number associated with the enhanced COM
port of the Silicon Lab USB-UART Bridge. Set up a new connection as in Figure 1-12, and
press the Return key to connect to view the System Controller options menu.

Port Settings
Bits per second: [115200 v]
Data bits: [B v]
Parity: [None v]
Stop bits: [‘I v]
Flow control: [None v]
[ ok ][ Cancel ][ ppt

X15551-121416

Figure 1-12: Terminal Setting
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5. From the main System Controller menu, select option (1) to access the SuperClock-2
options:

VCU1287 System Controller v1.0
- Main Menu -
1. Set Programmable Clocks
2. Get Power System (PMBUS) Voltages
3. Get Power Monitoring Data (INA226)
4. Adjust FPGA Mezzanine Card (FMC) Settings
5. Get GPIO Data
6. Get EEPROM Data
7. Configure UltraScale FPGA
Select an option

6. Use the Programmable Clocks menu option (2) to set the output clock frequencies of
the Si5368 clocks to 125 MHz.

VCU1287 System Controller v1.0
- Clock Menu -
1. Set VCU1287 Si570 Frequency
2. Set VCU1287 Si5368 Frequency
3. Save VCU1287 Clock Frequency to EEPROM
4. Restore VCU1287 Clock Frequency from EEPROM
5. View VCU1287 Saved Clocks in EEPROM
6. Set VCU1287 Clock Restore Options
7. Read VCU1287 Si570 Frequency
8. Read VCU1287 Si5368 Frequency

0. Return to Main Menu
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7. Select option 2 (Free-Run crystal) operating mode when prompted.
Choose si5368 operating mode:
1 - Auto-Select

2 - Free-Run using XA-XB crystal

Configuring the FPGA

The VCU1287 board additionally utilizes the Xilinx XC7Z010CLG225 Zynq-7000 AP SoC
System Controller to implement a System Integrated Configuration Engine (System ICE) to
configure the FPGA using one of the configuration * .bit files provided on the SD card in
8-bit SMAP configuration mode.

The FPGA can also be configured through the Vivado Design Suite using the *.bit files
available on the SD card and online (as collection rdf0368-vcul287-ibert-2016-4.zip)
at the Virtex UltraScale FPGA VCU1287 Characterization Kit documentation website.

Review UltraScale Architecture Configuration User Guide (UG570) [Ref 4] for additional
information about UltraScale device configuration.

1. Insertthe SD card provided with the VCU1287 board into the SD card reader slot located
on the bottom-side (upper-right corner) of the VCU1287 board.

2. From the main System Controller menu, select option (7) to access the UltraScale FPGA
configuration options:

VCU1287 System Controller v1.0
- Main Menu -
1. Set Programmable Clocks
2. Get Power System (PMBUS) Voltages
3. Get Power Monitoring Data (INA226)
4. Adjust FPGA Mezzanine Card (FMC) Settings
5. Get GPIO Data
6. Get EEPROM Data

7. Configure UltraScale FPGA
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3. Select option (1) to configure the FPGA from the SD card:
VCU1287 System Controller
- CONFIG Menu -
1. Configure UltraScale FPGA from SD Card
0. Return to Main Menu
Select an option

The IBERT design demonstrations included with the SD cards can be selected using one
of the set numbers listed in Table 1-1.

Table 1-1: IBERT Examples Bitstream Number

IBERT Demonstration Design Bitstream Number
QUAD_124 0
QUAD_125 1
QUAD_126 2
QUAD_127 3
QUAD_128 4
QUAD_129 5
QUAD_130 6
QUAD_131 7
QUAD_224 8
QUAD_225 9
QUAD_226 10
QUAD_227 11
QUAD_228 12
QUAD_229 13
QUAD_230 14
QUAD_231 15
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4. Select option (8) to configure the FPGA with the Quad 224 IBERT example design. Press
Enter and review the terminal for configuration progress:

Enter a Bitstream number (0-15):

8

Info: xilinx.sys opened

Info: Opening rev_1/set8/config.def

Info: Configuration definition file "rev_1/set8/config.def" opened
Info: Clock divider is set to 2

Info: Configuration clock frequency is 25MHz

Info: Bitfile "rev_1/set8/vu95Q224.bit" opened
..10%...20%...30%...40%...50%...60%...70%...80%...90%...100%

Configuration completed successfully

Setting Up the Vivado Design Suite

1. Connect the host computer to the VCU1287 board using the second standard-A plug to
micro-B plug USB cable. The standard-A plug connects to a USB port on the host
computer and the micro-B plug connects to J165, the Digilent USB JTAG configuration
port on the VCU1287 board (Figure 1-13).

DIGILENT
usBe

X15552-121416

Figure 1-13: JTAG Connector
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2. Start the Vivado Design Suite on the host computer and click Flow > Open Hardware
Manager (highlighted in Figure 1-14).

File | Flow | Tools ‘Window Help

Cuick Access

%  Open Hardware Manager ‘

VIVADO'

HLx Editions
Quick Start
Vi '! \ j |
&\ =
Create Mew Project Open Project

Tasks

Manage IP Open Hardware Manager

Information Center

%

Documentation and Tutorials Quick Take Videos

E__

Open Example Project

@

wilinz: Tol Skaore

N Ej

Release Motes Guide

& XILINX

ALL PROGRAMMABLE.

B Td Consale

Figure 1-14:
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Vivado Design Suite, Open Hardware Manager
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3. In the Hardware Manager window (Figure 1-15), click Open New Target.

File Edit Flow Tools Window Layout VYiew Help
AR BB X| | [E |2 pefaultLayout e & B IE*

Hardware Manager - unconnected

@ Mo hardware target is open. | Open target

Hardware %. Auta Connect g Probes — O @ =
e = $ ?5 %_ Pl M Recent Targets 3 E %
3
Mame
i OpenMew Target...

4 | 1 J

Properties

PN

X15554-121416

Figure 1-15: Open a New Hardware Manager

4. An Open Hardware Target wizard opens. Click Next in the first window.

5. In the Hardware Server Settings window, select Local server (target is on local
machine). Click Next.

VCU1287 IBERT Getting Started Guide N Send Feedback 20
UG1203 (v2016.4) December 15. 2016 www.xilinx.com l—\/—l



https://www.xilinx.com
http://www.xilinx.com/about/feedback.html?docType=User_Guides&docId=UG1203&Title=Virtex%20UltraScale%20FPGA%20VCU1287%20Characterization%20Kit%20IBERT&releaseVersion=2016.4&docPage=20

i: XI I_INX Chapter 1: VCU1287 IBERT Getting Started Guide

ALL PROGRAMMABLE-

6. In the Select Hardware Target window, the xilinx_tcf cable appears under Hardware
Targets, and the JTAG chain contents of the selected cable appear under Hardware
Devices (Figure 1-16). Select the xilinx_tcf_Digilent target and keep the JTAG Clock
Frequency at the default value (15 MHz). Click Next.

¢ Open New Hardware Target |_ §i§_|
Select Hardware Target
Select a hardware target from the list of available targets, then set the appropriate JTAG dodk (TCK)
frequency. If you do not see the expected devices, decrease the frequency or select a different target.
Hardware Targets
Type Mame JTAG Clock Freguency

- dlinx_tef |Digilent/210308957931

Hardware Devices (for unknown devices, spedfy the Instruction Register (IR) length

Mame ID Code IR Length
@ xovu095_0 13842093 6

Hardware server: localhost: 3121

< Back “ Mext = Finish Cancel |

X15555-121416

Figure 1-16: Select Hardware Target

7. In the Open Hardware Target Summary window, click Finish. The wizard closes and the
Vivado Design Suite opens the hardware target.

8. A dialog to auto-detect the I/O links for the IBERT cores is displayed if the Vivado
Design Suite default warnings and notifications setting has not been changed. Press Yes
to automatically detect the links (Figure 1-17).

Auto-detect Serial IYO Links |22

| Do you want to auto-detect serial 10 links for IBERT cores?

[~] Don't show this dialog again

I Yes ” o ]

X15556-121416

Figure 1-17: Auto-Detect the Serial 1/0 Links
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9. Alternatively, to view the GTH
From the top of the Hardware

Chapter 1: VCU1287 IBERT Getting Started Guide

transceiver operation, click Layout > Serial /O Analyzer.
Manager window, select Auto-Detect Links to display all

available links automatically. Links can also be created manually in the Links window by
right-clicking and selecting Create Links or by clicking the Create Links button

(Figure 1-18).

@ There are no serial 1O links. IAutD-deDecL links Create links I

Hardware — [l Debug Probes P i I
QS ER & P B, =
Name Status
Connected
Open
Programmed
-5 Quad_224 (5)
[l COMMON_X0Y0 0plld Locked
By MGT_X0YD 12.500 Ghps
B MGT_X0Y1 12,492 Gbps
B MGT_X0YZ 12.500 Ghps
Lo B2y MGT_X0Y3 12.511 Ghps
<[ T =
Hardware Device Properties PR (50 i
= =p B3
i xovuss5_0
Name: xcwu0g5_0 =
Part: xcvud95 =
ID code: 13842093 =
General | Properties
Serial 10 Links
= Ctrl+E
< X Delete Delete
= & Create Links...
[E ]
B I Auto-detect links or create links ‘I-'
[ ] =]
\;‘g" Commit Properties
@ Refresh Serial 1jO Objects
B Td Co Export to Spreadshest. . 5] Serial 1/0 Scans |

Figure 1-18:
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10. If links are created manually, the Create Links window is displayed. The options in this
window are used to link any TX GT to any RX GT. To create links, select the TX GT and RX
GT from the two lists, then click the Add (+) button. For this project, connect the
following links (Figure 1-19):

o MGT_X0YO/TX (xcvu095_0/Quad_224) to MGT_X0YO/RX (xcvu095_0/Quad_224)
o MGT_X0Y1/TX (xcvu095_0/Quad_224) to MGT_X0Y1/RX (xcvu095_0/Quad_224)
o MGT_X0Y2/TX (xcvu095_0/Quad_224) to MGT_X0Y2/RX (xcvu095_0/Quad_224)
o MGT_X0Y3/TX (xcvu095_0/Quad_224) to MGT_X0Y3/RX (xcvu095_0/Quad_224)

¢ CreateLinks (=23
To create a new link select a TX GT and/or an RX GT, then dick the Add button on the Mew Links toolbar, '
TX GTs RX GT=
Search: . Q- . Search: | O~
MGT_X0Y0/TX (xcvu095_0/Quad_224) MGT_X0Y0/RX {xcvul95_0/Quad_224)
[f> MGT_XOY1/T% {xcvu0as 24) <& MGT_X0Y 1L/RX (xcvuD95_0/Quad_224)
[f> MGT_X0Y2/TX <F] MGT_XO0Y2/RX {xcvuda5_0/Qu )
[E> MGT_X0Y3/TX {xc <3 MGT_XO0Y3/RX (xcvulgs_0/Qu
Mew Links
—
Press the E button to Add Link
Create link group
Link group description: | Link Group E|| i
[] Open Serial 1jO Analyzer layout

X15558-121416

Figure 1-19: Create Links Window
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Viewing GTH Transceiver Operation

After completing step 10, page 23 in Setting Up the Vivado Design Suite, the IBERT
demonstration is configured and running. The status and test settings are displayed on the
Links tab in the Links window shown in Figure 1-20.

Review the line rate and RX bit error count. The line rate for all four GTH transceivers is
12.5 Gb/s (see MGT Link Status in Figure 1-20). Verify that the there are no bit errors.

File Edit Flow Tools Window Layout View Help [ Q- search commands ]

2,0 02 W X | %6 [Escumomie <] B 8 X | 0wt~ | D

Hardware Manager - localhost/xiinx_tcf/Diglent/210308957933
Hardnare — O * X | DebugProbes
Z=EFE R v E ==
Name Status
- g1z E— R -
4F SysMon (System Monitor)
=-4F IBERT (I8ERT)
BBy Quad_224 (5)
[l COMMON_X0vD Qpld Locked
by MGT_X0Y0 12.500 Gbps
by MGT_X0Y1 12.461Gbps
4 i ] O
Hardware Device Properties 2 _ O x No content
Sl
 xcvu095_0
Name: xcvu0g5_0
Part: xovu0gs H
ID code: 03842093
IR length: 5
Szt Braaramme: A 2
Properties
Serial 1/O Links _owe x
2 Name ™ RX Status Bits BERTReset |TXPattern  RXPattern  TXPre-Cursor TXPost-Cursor  TX Diff Swing TXReset  RXReset |Loopb... | RXPLL... TXPLL...
X [ Ungrouped Links (1)
o B Link Group 0 (4) PRES 31-bit ~ PRBS 31bit v 0.00dB (00000) ~ 0.00dB (00000) ~ 950mV (1100) ~ MNone  ~
= g Linko MGT_X0Y0/TX MGT_X0Y0/R¥] 12.500 Gbps| 1.433€14 2 PRES 31bit ~ PRBS 31bit v 0.00dB (00000} ~ 0.00dB (00000) ~ 950mV (1100} ~ Mone  ~|Locked  Locked
E % Link 1 MGT_XOY 1/TX MGT_X0Y 1/R¥] 12.461 Gbps| 1. 43313 - PRES 31bit ~ PRES 31bit v 0.00dB (00000) ~ 0.00dB (00000) ~ 950my (1100) ~ None  ~[Locked  Locked
o % Link 2 MGT_X0Y2/TX MGT_X0Y2/R¥] 12.500 Gbps| 1. 43313 = PRES 31bit ~ PRES 31bit + 0.00dE (00000) ~ 0.00dB (00000) ~ 950my (1100) ~ None  ~[Locked  Locked
P % Link 3 MGT_X0Y3/TX MGT_X0Y3/R¥] 12.500 Gbps| 1. 43313 - PRES 31bit ~ PRES 31bit v 0.00dB (00000) ~ 0.00dB (00000) ~ 950my (1100) ~ None  ~[Locked  Locked
e < 1 ] 3
Tl Console | © Messages:, % Serial 1/0 Links | [&] Serial 1/0 Scans |

X15559-121416

Figure 1-20: Serial 1/0 Analyzer Links

In Case of RX Bit Errors

If there are initial bit errors after linking, or as a result of changing the TX or RX pattern, click
the respective BERT Reset button to zero the count.

If the MGT Link Status shows No Link for one or more transceivers:

« Make sure the blue elastomer seal is connected to the bottom of the Bulls Eye cable
and the cable is firmly connected and flush on the board.

« Increase the TX differential swing of the transceiver (to compensate for any loss due to
PCB process variation).

» Click the respective TX Reset button followed by BERT Reset.
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Additional information on the Vivado Design Suite and IBERT core can be found in Vivado
Design Suite User Guide: Programming and Debugging (UG908) [Ref 5] and in LogiCORE IP
Integrated Bit Error Ratio Tester (IBERT) for 7 Series GTX Transceivers: Product Guide for
Vivado Design Suite (PG132) [Ref 7].

Closing the IBERT Demonstration
To stop the IBERT demonstration:

1. Close the Vivado Design Suite by selecting File > Exit.
2. Place the main power switch SW1 in the OFF position.
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Running the GTY IBERT Demonstration

The GTY IBERT demonstration operates one GTY Quad at a time. This section describes how
to test GTY Quad 124. The remaining GTY Quads can be tested following a similar series of
steps.

Connecting the GTY Transceivers and Reference Clocks

Review Figure 1-1 for the location of the GTY transceiver Quads on the VCU1287 board.

All GTY transceiver pins and reference clock pins are routed from the FPGA to a connector
pad that interfaces with Samtec Bulls Eye connectors. Review Figure 1-2 for the pinout of
the MGT Bulls Eye connector pad.

Attach the GTY Quad Connector

Before connecting the Bulls Eye cable assembly to the board, firmly secure the blue
elastomer seal provided with the cable assembly to the bottom of the connector housing if
it is not already inserted (see Figure 1-4).

Attach the Samtec Bulls Eye connector to GTY Quad 124 (Figure 1-21), aligning the two
indexing pins on the bottom of the connector with the guide holes on the board. Hold the
connector flush with the board and fasten it by tightening the two captive screws.

X15560-121416

Figure 1-21: Bulls Eye Connector Attached to Quad 124
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GTY Transceiver Clock Connections

Refer to Figure 1-2 to identify the P and N coax cables that are connected to the CLKO
reference clock inputs. Connect these cables to the SuperClock-2 module as follows:

* CLKO_P coax cable — SMA connector J7 (CLKOUT1_P) on the SuperClock-2 module
e CLKO_N coax cable — SMA connector J8 (CLKOUT1_N) on the SuperClock-2 module

Note: Any one of the five differential outputs from the SuperClock-2 module can be used to source
the GTY reference clock. CLKOUT1_P and CLKOUT1_N are used here as an example.

GTY TX/RX Loopback Connections

Refer to Figure 1-2 to identify the P and N coax cables that are connected to the four
receivers (RX0, RX1, RX2, and RX3) and the four transmitters (TX0, TX1, TX2,and TX3). Use
eight SMA female-to-female (F-F) adapters (Figure 1-6) to connect the transmit and receive
cables as shown in Figure 1-7:

« TXO0_P — SMA F-F Adapter —» RX0_P
« TXO_N — SMA F-F Adapter - RXO_N
« TX1_P — SMA F-F Adapter —» RX1_P
« TX1_N — SMA F-F Adapter - RX1_N
« TX2_P — SMA F-F Adapter —» RX2_P
« TX2_N — SMA F-F Adapter - RX2_N
« TX3_P — SMA F-F Adapter —» RX3_P
 TX3_N — SMA F-F Adapter — RX3_N

Note: To ensure good connectivity, it is recommended that the adapters be secured with a wrench;
however, do not over tighten the SMAs.
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Figure 1-22 shows the VCU1287 board with the cable connections required for the Quad
124 GTY IBERT demonstration.

_ ~ B
UltraSCALE-

X15561-121416

Figure 1-22: Cable Connections for Quad 124 GTY IBERT Demonstration

Starting the SuperClock-2 Module

The SuperClock-2 module provides LVDS clock outputs for the GTH and GTY transceivers
reference clock in the IBERT demonstration. For both of the GTH and GTY IBERT

demonstrations, the output clock frequency is preset to 125.00 MHz. See the description for
Starting the SuperClock-2 Module, page 13, for more details.
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Configuring the FPGA

Similar to the GTH IBERT example, the VCU1287 board can be configured using the onboard
Xilinx XC7Z010CLG225 Zynqg-7000APSoC System Integrated Configuration Engine
(SystemICE) in 8-bit SMAP configuration mode. Or the FPGA can be configured through the
Vivado Design Suite using the * . bit files available on the SD card and online (as collection
rdf0368-vcul287-ibert-2016-4.zip) at the Virtex UltraScale FPGA VCU1287
Characterization Kit documentation website.

Review UltraScale Architecture Configuration User Guide (UG570) [Ref 4] for additional
information about the UltraScale device configuration.

1. Insertthe SD card provided with the VCU1287 board into the SD card connector located
on the bottom-side (upper-right corner) of the VCU1287 board.

2. From the main System Controller menu, select option (7) to access the UltraScale FPGA
configuration options.

VCU1287 System Controller v1.0
- Main Menu -
1. Set Programmable Clocks
2. Get Power System (PMBUS) Voltages
3. Get Power Monitoring Data (INA226)
4. Adjust FPGA Mezzanine Card (FMC) Settings
5. Get GPIO Data
6. Get EEPROM Data
7. Configure UltraScale FPGA
Select an option
3. Select option (1) to configure the FPGA from the SD card.

VCU1287 System Controller v1.0

- CONFIG Menu -
1. Configure UltraScale FPGA from SD Card

0. Return to Main Menu
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4. Select option (0) to configure the FPGA with the Quad 124 IBERT example design. Press
Enter and review the terminal for configuration progress.

Enter a Bitstream number (0-15):

0

Info : xilinx.sys opened

Info : Opening rev_1/set0/config.def

Info : Configuration definition file "rev_1/set0/config.def" opened
Info : Clock divider is set to 2

Info : Configuration clock frequency is 25MHz

Info : Bitfile "rev_1/set0/vu95Q124.bit" opened
..10%...20%...30%...40%...50%...60%...70%...80%...90%...100%

Configuration completed successfully
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Setting Up the Vivado Design Suite

1. Connect the host computer to the VCU1287 board using the second standard-A plug to
micro-B plug USB cable. The standard-A plug connects to a USB port on the host
computer and the micro-B plug connects to J165, the Digilent USB JTAG configuration
port on the VCU1287 board (Figure 1-13).

2. Start the Vivado Design Suite on the host computer and click Flow > Open Hardware

Manager (highlighted in Figure 1-23).

File | Flow | Tools Window  Help Quick Access

I
¥  Open Hardware Manager |

VIVADO! £ XILINX

HLx Editions ALL PROGRAMMABLE.
Quick Start
A\ 4
1 =L .
b 7
Create Mew Project Open Project Open Example Project
Tasks
/. @z I.‘i
=—E
/ ] |

Manage IP Open Hardware Manager Yilim Tel Stare

Documentation and Tutorials Quick Take Videos Release Notes Guide

Information Center

5 Tcl Consale

X15553-121416

Figure 1-23: Vivado Design Suite, Open Hardware Manager
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3. In the Hardware Manager window (Figure 1-24), click Open New Target.

File Edit Flow Tools Window Layout Wiew Help

,?|E|m“%ﬁ3x|%||9 IS5 Default Layout i H&\RJ@

| Hardware Manager - unconnected

@ Mo hardware target is open. | Open target

Hardware % Auta Connect g Probes — O @ =
e = $| E > H Recent Targets y [ = |E
Closed Targets 3
Mame =
i OpenMew Target...

1| i | r

Properties

« = [&x

X15554-121416

Figure 1-24: Open a New Hardware Manager

4. An Open Hardware Target wizard opens. Click Next in the first window.

5. Inthe Hardware Server Settings window, select Local server (target is on local machine).
Click Next.
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6. In the Select Hardware Target window, the xilinx_tcf cable appears under Hardware
Targets, and the JTAG chain contents of the selected cable appear under Hardware
Devices (Figure 1-25). Select the xilinx_tcf_Digilent target and keep the JTAG Clock
Frequency at the default value (15 MHz), click Next.

¢ Open New Hardware Target |__§i§_|
Select Hardware Target
Select a hardware target from the list of available targets, then set the appropriate JTAG dodk (TCK)
frequency. If you do not see the expected devices, decrease the frequency or select a different target.
Hardware Targets
Type Mame JTAG Clock Freguency

- dlinx_tef |Digilent/210308957931

Hardware Devices (for unknown devices, spedfy the Instruction Register (IR) length

Mame ID Code IR Length
@ xovu095_0 13842093 6

Hardware server: localhost: 3121

< Back “ Mext = Finish Cancel |

X15555-121416

Figure 1-25: Select Hardware Target

7. In the Open Hardware Target Summary window, click Finish. The wizard closes and the
Vivado Design Suite opens the hardware target.

8. A dialog to auto-detect the I/O links for the IBERT core will be displayed if the Vivado
Design Suite default warnings and notification have not been changed. Press Yes to
automatically detect the links (Figure 1-26).

Auto-detect Serial IYO Links |22

| Do you want to auto-detect serial 10 links for IBERT cores?

[~] Don't show this dialog again

I Yes ” o ]

X15556-121416

Figure 1-26: Auto-detect the Serial 1/0 Links
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9. Alternatively, to view the GTY transceiver operation, click Layout > Serial I/O Analyzer.
From the top of the Hardware Manager window, select Auto-Detect Links to display all
available links automatically. Links can also be created manually in the Links window by
right-clicking and selecting Create Links, or by clicking the Create Links button

(Figure 1-27).

(i) There are no serial /O Iinks.l.-ﬂ.utn-dete-:r. links Create links I

Hardware TreE O L A
QA< SE &P
Mame Status
=~ B localhost (1) Connected
E-Be wiinx_tcfDigilent/210308957931 (1) Open
=& xowud35_0 (2) Programmed
H £ em ||
=B Quad_124 (5
i [f}] COMMON_X0Y0 Oplio Locked
B MET_X0Y0 28.000 Gbps
B MGT_X0Y1 23.000 Gbps
&by MGT_x0Y2 27.86% Ghps
By MGT_X0Y3 23.000 Ghps
¢ 1 - =
Properties e o] i 2
= wp B I
Sele object to see properties
Serial IO Links
=N Ctrl+E
7: A Delete Delete
‘_ @ Create Links...
¥
=
Eﬁj Commit Properties
= @ Refresh Serial IO Objects
o Export to Spreadsheet...

BT1d Conscle | Méssages %, Serial IO Links | [&] Serial I,’(EJ Scans |

Figure 1-27:

IAuto{ie{r:-:i links or create Iinksl‘_-:- add serial 1/C
1

X15563-121416

Serial 1/0 Analyzer - Create Links

10. If links are created manually, the Create Links window is displayed. The options in this
window are used to link any TX GT to any RX GT. To create links, select the TX GT and RX
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GT from the two lists, then click the Add (+) button. For this project, connect the
following links (Figure 1-28):

o MGT_X0YO/TX (xcvu095_0/Quad_124) to MGT_X0YO/RX (xcvu095_0/Quad_124)
o MGT_X0Y1/TX (xcvu095_0/Quad_124) to MGT_X0Y1/RX (xcvu095_0/Quad_124)
o MGT_X0Y2/TX (xcvu095_0/Quad_124) to MGT_X0Y2/RX (xcvu095_0/Quad_124)
o MGT_X0Y3/TX (xcvu095_0/Quad_124) to MGT_X0Y3/RX (xcvu095_0/Quad_124)

sy s
To create a new link select a TX GT and/or an RX GT, then dlick the Add button on the Mew Links toclbar. ‘
TX GTs RX GT=
Search: | C.- . Search: . Q-
MGT_X0¥0 TX (xovu035_0/Quad_124) MGT_XOYO/RX (xovu095_0/Quad_124)
[ MGT_XOY 1/TX (x D/Quad_124) < MGT_XOY1/RX (xcvul35_0/Quad_124)
[> MGET_XOY2/TX [x ) < MGT_X0Y2Z/RX )
[F> MGT_%0Y3/T% (% <& MGT_X0Y3/RX (xcwu0g5_|
New Links
-
Press rJ'-i_m:i;:-n to Add Link
[¥] Create link group
Link group description: | Link Group 0|
[7] Open Serial IO Analyzer layout
X15564-121416

Figure 1-28: Create Links Window
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Viewing GTY Transceiver Operation

After completing step 10 above page x in Setting Up the Vivado Design Suite, page 18, the
IBERT demonstration is configured and running. The status and test settings are displayed
on the Links tab in the Links window shown in Figure 1-29.

Review the line rate and RX bit error count. The line rate for all four GTY transceivers is
28.0 Gb/s (see MGT Link Status in Figure 1-29). Verify that the there are no bit errors.

Fle Edt Flow Tools Window Layout View Help [ Q- search commands |

200 DR X K § Hewiormns < # 8 % Sowon-| &

Hardware Manager - localhost/dlinx_tcf/Digilent/210308957933
Hardware —O2 X Debug Probes — O
T=ER R vi»m ==
Name Status
B 5 xcvu095 0(2)
5% SysMon (System Monitar)
-4 IBERT (IBERT)
E1-8)1 Quad_124 (5)
[ COMMON_X0Y0 Qpll0 Locked
B MGT_X0Y0D 27.972 Gbps
B MGT_XOY1 28,000 Gbps
By MGT_X0Y2 28.025Ghps | |}
t-By MGT_X0Y3 28.000Ghps ~ |
Al 15, | CIE No content
Hardware Device Properties T 0O X
e
% xcvuD95_0
MName: xcvu95_0 E
Part: xcvul95
1D code: 03842093 —
e
Serial I/0 Links _gwe x
C\ Name T RX Status Bits Errors BER BERT Reset | TX Pattern RX Pattern TX Pre-Cursor TX Post-Cursor TX Diff Swing TX Reset RX Reset Loopbac... |RXPLL... TXPLL.. |1l
X, [ Ungrouped Links (0)
iy -6 Link Group 0 (4) (_Reset J|PRBS 31-hit ~ PRBS 31-hit ~ 0.00dB (00000) ~ 0.00 dB (00000) ~ 556 mV (01100) ~ Mone  ~
e S Link0 MGT_X0¥0/TX MGT_xavo/Rxd 27.979 Gbps|2.33913 0E0|4.275E-14 PRES 31-bit ~ PRBS 31-hit = 0.00 dB (00000) ~ 0.00 dB (00000) ~ 556 mV (01100) ~ Mone flocked  Locked
& S Link 1 MGT_X0¥1/TX MGT_x0v 1/Rx] 28.000 Gbps|2.339E13 0E0|4.275E-14 PRBS 31-hit ~ PRBS 31-hit = 0.00 dB (00000) ~ 0.00 dB (00000) 556 mV (01100) = Mone flocked  Locked
o S Link 2 MGT_X0¥2/TX MGT_x0v2/Rx] 28.025 Ghps|2.339E13 0E0|4.275E-14 PRES 31-bit ~ PRBS 31-bit = 0.00 dB (00000) ~ 0.00 dB (00000) ~ 556 mV (01100) ~ Mone  « flocked  Locked
& S Link 3 MGT_XO0¥3/TX MGT_x0Y3/Rx] 28,000 Gbps|2.339E13 0E0|4.2756-14|_Reset RBS 31-bit ~ PRBS 31-bit + 0.00 dB (00000) ~ 0.00 dB (00000) ~ 556 mV (01100) + Mone v |locked  Locked
e ! il ] b
[ Td Console | () Messages-, % Serial 1/0 Links | [ Serial /0 Scans |

X15565-121416

Figure 1-29: Serial 1/0 Analyzer Links

In Case of RX Bit Errors

If there are initial bit errors after linking, or as a result of changing the TX or RX pattern, click
the respective BERT Reset button to zero the count.

If the MGT Link Status shows No Link for one or more transceivers:

« Make sure the blue elastomer seal is connected to the bottom of the Bulls Eye cable
and the cable is firmly connected and flush on the board.

« Increase the TX differential swing of the transceiver (to compensate for any loss due to
PCB process variation).

+ Click the respective TX Reset button followed by BERT Reset.
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Additional information on the Vivado Design Suite and IBERT core can be found in Vivado
Design Suite User Guide: Programming and Debugging (UG908) [Ref 5] and in LogiCORE IP
Integrated Bit Error Ratio Tester (IBERT) for 7 Series GTX Transceivers: Product Guide for
Vivado Design Suite (PG132) [Ref 7].

Closing the IBERT Demonstration
To stop the IBERT demonstration:

1. Close the Vivado Design Suite by selecting File > Exit.

2. Place the main power switch SW1 in the off position.
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Creating the GTH IBERT Core

The Vivado® Design Suite 2016.4 is required to rebuild the designs shown here.

This section provides a procedure to create a single Quad GTH IBERT core. The procedure
assumes Quad 224 at 12.5 Gb/s line rate, but cores for any of the GTH Quads with any
supported line rate can be created following the same series of steps.

For more details on generating IBERT cores, see the Vivado Design Suite User Guide:
Programming and Debugging (UG908) [Ref 5].

1. Start the Vivado Design Suite.

File Flow Tools Wwindow Help Quick Access

VIVADO' £ XILINX

HLx Editions LL PROGRAMMABLE.

Quick Start

=) = =

Create MNew Project Open Project ©Open Example Project

Tasks

y)

M
e

Manage IP Open Hardware Manager wilinz: Tel Store

Information Center

2 B8 @

Documentation and Tutarials Quick Take Videos Release Maotes Guide

B Tel Consale
X15566-121416

Figure 2-1: Vivado Design Suite Initial Window

VCU1287 IBERT Getting Started Guide N Send Feedback 38
UG1203 (v2016.4) December 15. 2016 www.xilinx.com [—\/—]



https://www.xilinx.com
http://www.xilinx.com/about/feedback.html?docType=User_Guides&docId=UG1203&Title=Virtex%20UltraScale%20FPGA%20VCU1287%20Characterization%20Kit%20IBERT&releaseVersion=2016.4&docPage=38

8 X”_INX Chapter 2: Creating the IBERT Cores

ALL PROGRAMMABLE-

2. In the Vivado Design Suite window, click Manage IP (highlighted in Figure 2-1) and
select New IP Location.

3. A Create a New Customized IP Location dialog window opens (not shown), Click Next.

4. In the Manage IP Settings window, select a part by clicking the (...) button next to the
Part field. A Select Device window displays. Use the drop-down menu items to narrow
the choices. Select the xcvu095-ffvb2104-3-e device (see Figure 2-2). Click OK.

# Select Device
Filter, search, and browse parts by their resources, The selection will be applied. ‘
Select: | @ Pgns. [ Boards
4 Filter

Product category: | All - Speed grade: | -3 >

Eamily: Virtex UltraScale - Temp grade: | All Remaining -

Package: ffub2104 -

| Resst Al Fitters
Search: Q) -
IO Pin Block S GTHE3 GTYE3 Gh

Fak Count RAMs D5 FiifFiops Transceivers  Transceivers  Tral
& xcvuDB0-fivb2104-3¢ 2,104 G 1421 Y 672 G 891429 G 32 % 32 % €

|57 xowu095-fvb2104-3=

4 1 (=)
=N

X15567-121416

Figure 2-2: Select Device
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5. Back on the Manage IP Catalog window, select Verilog for Target language, Vivado
Simulator for Target simulator, Mixed for Simulator language, and a directory to save
the customized IP (Figure 2-3). Click Finish.

Note: Make sure the directory name does not include spaces.

¢ MNewlIP Location @
Manage IP Settings
Set options for creating and generating IP. ’
Part: @ xovu095-fub2104-32 ™
Target language: Verilog -

Target simulator: Vivado Simulatar -

Simulator language: | Mixed

s

I location: H: fvCU1287]

< Back Mext = Finish | | Cancel

X15568-121416

Figure 2-3: Manage IP Settings
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6. In the IP Catalog window, expand the Debug & Verification folder, expand the Debug

folder, and double-click IBERT UltraScale GTH (Figure 2-4).

J {F IP Catalog X |

Interfaces |

"’D Marme

== Vivado Repositary
(- Alliance Partners
([ Autamotive & Industrial
= A% Infrastructure
- BassIP
[+ Basic Elements

== Debug & Verification
== Debug

LF IEERT 7 Series GTZ

|| & (B @ B o | R B

LF IBERT Ultrascale GTY

~4F In System IEERT
~4F ITAG ko AXT Master
~1F Swskern ILA

~4F ILA (Inkegrated Logic Analyzer) AxI4, AxI4-Skream

axl4

IF'r'l:lllel:til:lrl
Production
Production
Production
Production
Production

1L
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Figure 2-4: 1P Catalog
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7. A Customize IP window opens. In the Protocol Definition tab, set the LineRate(Gbps)
to 12.5. Change Refclk(MHz) to 125. Keep defaults for other fields (Figure 2-5).

ﬁ Customize IP

IBERT Ultrascale GTH (1.3) ’

ﬁ’l Documentation | IP Location Ll Switch to Defaults

|| Show disabled ports Component Name | ibert_ultrascale_gth_|

Protocol Definition | Protocol Selection | Clock Settings | Summary

The i ber of quads available for this device is 8

Number of Protocols 1 b
wn_i[3:0] Protocol LineRate(Gbps) DataWidth Refclk{MHz) Quad Count PLL
gtrefclki if0:0]
gtrefcllkl_[0:0]
gtrorthrefcllko_ilo:0]
gtrorthrefclld_if0:0]
qtsauthrefcllko_il0:0]
qtsouthrefcll 1if0:0]
gtrefclka0_i[0:0]
qbreflk 10_i[0:0] ben_o[Z:0]m
gtreficlkol_il0:0] tip_o[50]
\trefclk 11 i[0:0] rroutclk_o[3:0]
gtricrthefclkon_i[0:0]
atricrthefelk 10_i[0:0]
atrorthefellkol_i[o:0]
gtrorthrefcll i1 i[0:0]
tsouthrefclkon_i[0:0]
qtsouthrefclk 10_i[0:0]
qtsouthrefclkiod_i[0:0]
qtsouthrefclk 11 i[0:0]
k.

==

X15570-121416

Figure 2-5: Customize IP — Protocol Definition
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8. In the Protocol Selection tab, use the Protocol Selected drop-down menu next to
QUAD_224 to select Custom 1/12.5 Gb/s (Figure 2-6).

iFCuﬁomhem

IBERT Ultrascale GTH (1.3)

ﬂ Documentation | IP Location (£ Switch to Defaults

wr_i[3:0]

wp_i[30]
igtrefclkn_i[o:0]
igtrefclk 1 i[0:0]
gtnortheefclkn_if0:0]
gtnorthrefclk 1 i[0:0]
gtsauthrefcllkn_if0:0]
gtsouthrefclk 1 i[0:0]
gtrefcllnn_i[0:0]
qtreFelk 10_i[0:0]
gtrefcllnd_i[0:0]
qtreFelk 11 i[0:0]
qtnartheefcllknn_ifo:0]
atncrthrefclk 10_i[0:0]
qtnorthrefclknd_ifo:0]
gtnorthrefclk 11_i[0:0]
igtsouthrefclkno_ifo:0]
gtsouthreficlk 10_i[0:0]
igtsouthrefcllknl_ifo:0]
gtsouthreficlk11_i[0:0]
3

il

txn_c[3:0]

tep_a[3:0]
veautelle cfz01}

VCU1287 IBERT Getting Started Guide
UG1203 (v2016.4) December 15. 2016

Figure 2-6:

Component Mame | ibert_ultrascale_gth_0

Protocol Deﬁn\ﬁo_n " Protocol Selection | Clock Settings | Summary

GTH Location
QUAD_224
QUAD_225
QUAD_225
QUAD_227
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QUAD_231
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Customize IP — Protocol Selection
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9. In the Clock Settings tab, select DIFF SSTL15 for the I/O Standard, enter AW14 for the
P Package Pin (the FPGA pins to which the system clock is connected), and make sure
the Frequency (MHz) is set to 300 (Figure 2-7).

ﬁ Customize IP

IBERT Ultrascale GTH (1.3)

ﬂ Documentation || IP Location ([ Switch to Defaults

*n_i[3:0]

xp_i[3:0]
gtrafcll0_i[0:0]
egtraficll1_i[0:0]
tmorthrefcllko_i[0:0]
qtmorthrefclld i[0:0]
gtsouthrefcllan_i[0:0]
gtsouthrafclkl_i[0:0]
gtrefclb0_il0: 0]
gtrefelk 10_i[0: 0]
gtreficll01_i[0:0]
qtreflle 11_i[0:0]
qtrarthrefcllnn_ilo:0]
qtrarthrefcll 10_i[0: 0]
qtrorthrefcllknd ifo:0]
gtrarthrefclk11_i[0:0]
igtsouthrefcllk0n_ilo: 0]
qtsouthrefclk10_i[0:0]
iqtzouthrefcllkn_i[o:0]
qtsouthrefclik1_if0:0]
k.

ter_a[3:0]
txp_a[3:0]
rxoutclk_a[2:0]
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Protocol Definition | Protocol Selection” Clock Settings | Summary
[] Add RXOUTCLK Probes
Clock Type Source 1/0 Standard P Package Pin Frequency(MHz)
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System Clock Termination Settings

[#] Enable DIFF Term
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Figure 2-7: Customize IP - Clock Settings
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10. Click OK. Click Generate in the next window to generate the output products
(Figure 2-8).

¢  Generate OQutput Products @

The following output products will be generated.

Preview

L ibert_ultrascale_gth_0.xci (00C per IP)
i Instantiation Template

= =il Synthesized Checkpaint {.dcp)
% L[4l Change Log

Synthesis Options
@ Global
") Out of context per IP

Run Settings

Mumber of jobs: | 1 -

Apply H Generate ][ Skip

X15572-121416

Figure 2-8: Generate Output Products
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11. Back on the Manage IP Catalog window, in the Sources window, right-click the IBERT IP
and select Open IP Example Design (Figure 2-9). Specify a location to save the design,
click OK, and the design opens in a new Vivado Design Suite window.

Project Manager - xcvu095-Fivb2104-3-2
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Cores

'}ﬂ [ame:

Interfaces o

Source File Properties, .,
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Generate Output Products, .,

Reset Qukput Products. ..

Copy IP...

Ctrl+E

= Debug & Yerification
-7 Debug

--{F Debug Bridge

4 IBERT 7 Series GTH
- IBERT 7 Series GTP
--4fF IBERT 7 Series GTH
g IEERT 7 Seties GTZ

-2F IBERT Ultrascale GTY

Dpen IP Example Design, .,

-4F ILA {Inkegrated Logic Anakyzer)

- Sources

_Jl'l__‘J Gl

t A== 2E

[= 8

z =& P

™ EERRMib et ultrascale_gth
3
i
=
el
X
@
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IP Docurment ation

Repart IP Skatus

Remove IP From Project. ..

Set Used In...
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Delete

~4F In System IBERT
-LF ITAG to AXI Master

£ SR N g VRN

(L

Select an IP or Inketface or Feposit
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Figure 2-9: Open IP Example Design
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12.1In the Sources window, Design Sources should now show the IBERT design example

(Figure 2-10).

Project Manager - ibert_ultrascale_gth_0_example

Sources

O 59 g
(=S

i ot B

[+ Design Sources (3]

| E-i8ds example_ibert_ultrascale_gth_0 (=xamp
-4k u_ibert_gth_core - bert_ultrascale_gth_0 (ib

m

er

| Text (2)

é--i.-—. Constraints (1)

=+ constrs_1 (1)

&4 example_ibert_ultrascale_gth_0.xdc

[#-I5 Simulation Sources (3)

4|

Hierarchy | IF Sources | Libraries

2 Sources

I

% Templates

Compile Order

X15574-121416

Figure 2-10: Design Sources File Hierarchy
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13. Click Run Synthesis from the Flow Navigator to synthesize the design (Figure 2-11).

Flow Mavigator 4
Gl g
O\ (=SS
4 Project Manager
ﬁ. Project Settings
o‘ﬁ‘ Add Sources

.‘-_,J Language Templates
1F 1P Catalog

> IP Integrator
> Simulation
> RTL Analysis

4 Synthesis
ﬁ. Synthesis Settings
$- Run Synthesis

> [ Open Synthesized Design

4 Implementation
ﬁ Implementation Settings
[» Run Implementation

> [ Open Implemented Design

4 Program and Debug
ﬁ. Bitstream Settings
‘I’ﬂ Generate Bitstream
» Ha Open Hardware Manager

X15575-121416

Figure 2-11: Run Synthesis
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14. When the synthesis is done, a Synthesis Completed window opens. Select Run
Implementation and click OK (Figure 2-12).

g

Synthesis Completed

Mext

i@ Run Implementation

(") Open Synthesized Design

(™) Wiew Reports

[] Don't show this dialog again

X15576-121416
Figure 2-12: Synthesis Completed

15. When the implementation is done, an Implementation Completed window opens. Select
Generate Bitstream and click OK (Figure 2-13).

Implementation Completed @

(7 View Reports

[] Don't show this dialog again

=]

X15577-121416

Figure 2-13: Implementation Completed
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16. When the Bitstream Generation Completed dialog window appears, click Cancel
(Figure 2-14).

Bitstream Generation Completed @

:I Bitstream Generation successfully completed.

i) Open Implemented Design

() Miew Reports

(@ Dpen Hardware Manager:

[] Don't show this dialog again

0K ]I[ Cancel ]I

X15578-121416
Figure 2-14: Bitstream Generation Complete

17. Navigate to the
...\libert_ultrascale_gth_0_example\ibert_ultrascale_gth_0_exampl
e.runs\impl_1 directory to locate the generated bitstream.
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Creating the GTY IBERT Core

The Vivado Design Suite 2016.4 is required to rebuild the designs shown here.

This section provides a procedure to create a single Quad GTY IBERT core. The procedure
assumes Quad 124 at 28.00 Gb/s line rate, but cores for any of the GTY Quads with any
supported line rate can be created following the same series of steps.

For more details on generating IBERT cores, see Vivado Design Suite User Guide:
Programming and Debugging (UG908) [Ref 5].

1.
2.

VCU1287 IBERT Getting Started Guide

Start the Vivado Design Suite.

In the Vivado Design Suite window, click Manage IP (highlighted in Figure 2-1) and
select New IP Location.

A Create a New Customized IP Location dialog window opens. Click Next.

In the Manage IP Settings window, select a part by clicking the (...) button next to the
Part field. A Select Device window displays. Use the drop-down menu items to narrow
the choices. Select the xcvu095-ffvb2104-3-e device (Figure 2-2). Click OK.

Back on the Manage IP Catalog window, select Verilog for Target language, Vivado
Simulator for Target simulator, Mixed for Simulator language, and a directory to save
the customized IP (Figure 2-3). Click Finish.

Note: Make sure the directory name does not include spaces.

o l Send Feedback I 51
UG1203 (v2016.4) December 15. 2016 www.xilinx.com



https://www.xilinx.com
http://www.xilinx.com/about/feedback.html?docType=User_Guides&docId=UG1203&Title=Virtex%20UltraScale%20FPGA%20VCU1287%20Characterization%20Kit%20IBERT&releaseVersion=2016.4&docPage=51

8 X”_INX Chapter 2: Creating the IBERT Cores

ALL PROGRAMMABLE-~

6. In the IP Catalog window, expand the Debug & Verification folder, expand the Debug
folder, and double-click IBERT UltraScale GTY (Figure 2-15).

|- 1P Catalog x| O C
Inkerfaces | Search: | O
- 1
"D MName axld Skatus License

=1 Vivado Repositary:
G+ Alliance Partners
B[ Automotive & Industrial
G+ AxI Infrastructure
[+ BaseIP
([ Basic Elements
--F.j Communicakion & Mebworking
== Debug & Yerification

|

m

&
E
1y
)
W
@l
®

== Debug
--1F Debug Eridge Praduckion Included
-3 IBERT 7 Series GTH Included R
--3F IEBERT 7 Series GTP Included
--3F IEERT 7 Series GTE Included
--3F IBERT 7 Series GTZ Included

- {F IBERT Ultrascale GTH Praduckion Included

B IBERT Ultrascals GTY | |Production |Included
~3F ILA (Inteqrated Logic Anakwzer) B8¥14, A¥I4-Skream  Produckion Included
~4F In Systemn IBERT Praduckion Included
-4F ITAG ko AXT Masker AT Production Included
~4F System IL& Production Included -
1| ] | 3

X15579-121416

Figure 2-15: IP Catalog
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Chapter 2: Creating the IBERT Cores

7. A Customize IP window opens. In the Protocol Definition tab, set the LineRate(Gb/s) to
28.00. Change Refclk(MHz) to 125. Keep defaults for the other fields (Figure 2-16).

ﬁ Customize IP

IBERT Ultrascale GTY (1.2)

ﬂ Documentation || IP Location [ Switch to Defaults

|| Show disabled ports

rxn_i[3:0]

rxp_i[3:0]
ghrefclki_i[0:0]
gtrefclkl if0:0]
gtnorthrefclki_i[0:0]
gtnorthrefclkd _i[0:0]
gtsouthrefclko_i[0:0]
gtsouthrefclkl_i[0:0]
igtrefclkon_i[0:0]
igtreficlk 10_i[0:0]
igtreficlkid_i[o:0]
igtraficlk 11 _i[0:0]
igtnorthrefcllkon_i[o:0]
gtnorthrefcll10_i[0:0]
igtmorthrefcllkol_i[o:0]
gtnorthrefcll11_i[0:0]
gtzouthrefcllon_i[0:0]
gtsouthrefelk 10_i[0:0]
gtsouthrefcllko1_i[0:0]
gtsouthrefelk 11 i[0:0]
clk

txn_a[3:0] m=
txp_a[3:0]

Figure 2-16:
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Component Name ibert_ulh'ascalegty_0|

Protocol Definition | Protocol Selection | Clock Settings | Summary

The il ber of quads ilable for this device is B

Number of Protocols 1 o
Protocol LineRate(Gbps) DataWidth Refclk{MHz) Quad Count PLL
Custom1  ~fosoo o ~ s i T QPO -

==

X15580-121416

Customize IP- Protocol Definition
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8. In the Protocol Selection tab, use the Protocol Selected drop-down menu next to
QUAD_124 to select Custom 1 / 28.00 Gbps (Figure 2-17).

i} Customize IP

IBERT Ultrascale GTY (1.2) '

ﬁi Documentation [ IP Location [l Switch to Defaults

Component Name | ibert_ultrascale_gty_0
Protocol Deﬁniﬁo_n " Protocol Selection | Clock Settings | Summary

Please select Protocol-Quad combination

Fxr_i[3:0]

Fxp_i[3:0]
gtrefcllo_i[0:0]
gtrefclk 1 _if0:0]
gtnaorthrefclko_i[0:0]
gtrorthreficlk 1_il0:0]
gtzouthrefclko_ilo:0]
atsauthrefclkd i[0:0]
gtrefcllkno_ifo:0]
gtrefelk 10_i[0:0]
gtrefcllknl_if0:0]
gtrefcll 11 i{0:0]
gtnorthrefclkoo_i[0:0]
gtrorthrefcllk 10_i[0:0]
gtrorthrefclkol i[o:0]
gtrarthrefclk 11_i[0:0]
gtsouthrefclkoo_i[o:0]
gtzouthrefcllk 10_i[0:0]
gtsouthrefclkol i[0:0]
gtsouthrefclk 11 i[0:0]
clk

GTY Location Protocol Selected Refclk Selection
QUAD_124 ustom 1 / 28.00 Gbps ~ MGTREFCLKO 124 -
QUAD_125 Mone - Mone .
QUAD_126 Mone = MNone b
QUAD_127 Mone - Mone .
QUAD_128 Mone = Mone b
QUAD_129 Mone ~ None -
QUAD_130 MNone = None -
bxr_o[3:0] = QUAD_131 Mone * Mone b

txp_o[3:0] ==

oK. | Cancel
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Figure 2-17: Customize IP- Protocol Selection
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9. Inthe Clock Settings tab, select DIFF SSTL15 for the I/O Standard, enter AW14 for the
P Package Pin (the FPGA pins where the system clock is connected), and make sure the
Frequency (MHz) is set to 300 (Figure 2-18).

Q Customize [P 53 _.l
IBERT Ultrascale GTY (1.2) ’

ﬁ’ﬂ Documentation | IP Location L) Switch to Defaults

[7] Show disabled ports Component Name |ibert_ultrascale_gty_0
Protocol Definition | Protocol Selection Clock Settings | Summary

[] Add RXOUTCLK. Probes

rari[3:0] Clock Type Source 1/0 Standard P Package Pin Freq y(MHz)
g i[3:0] System Clock External - IDIFF S5TL15 v | AW14 300 I

gtrefclko_i[0:0] System Clock Termination Settings
gtrefclk 1 i[0:0]
gtriorthrefcllo_i[0:0] [#] Enable DIFF Term
gtrorthrafclkl_i[0:0]
gtsouthrefclln_i[0:0]
atsouthrefclkd_[0:0]
gtrefclkn_if0:0]
gtrefclk 10_i[0:0]
gtrefclkid if0:0]
gtrefclk 11_i[0:0]
gtrortheefcllkon_i[0:0]
gtnarthrefcll10_i[0:0]
gtrorthreficlkol_i[0:0]
gtnorthrefcllk11_i[0:0]
gtsouthrefclknn_ilo:0]
gtsouthrefclk 10 i[0:0]
gtsouthrefcllkn_i[o:0]
gtsouthrefclk 11 i[0:0]
clk.

ten_o[3:0] =
txp_o[3:0] ==

(o

X15582-121416

Figure 2-18: Customize IP— Clock Settings
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10. Click OK. Click Generate in the next window to generate the output products

(Figure 2-19).

Figure 2-19:

VCU1287 IBERT Getting Started Guide
UG1203 (v2016.4) December 15. 2016
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11. Back on the Manage IP Catalog window, in the Sources window, right-click the IBERT IP
and select Open IP Example Design (Figure 2-20). Specify a location to save the design,
click OK, and the design opens in a new Vivado Design Suite window.

Project Manager - xcvul95-fivb2104-3-2

P Sour'-cif - A I (N E {FIP Catalog X
A=
= Cores | Interfaces 3
i == P a1
] ERFbert_ultrascalz_ghy_0 (67 | name
4 Source File Properties... Chrl+E

[ Debug & werificakion
Enable Core Container == Debug

i¥ Re-customize IP... +4F Debug Br|dg.e

~4F IBERT 7 Series GTH
Generate Oubput Products, . - 4F IBERT 7 Series GTP
Reset Oukput Producks, . --4F TBERT 7 Series GTX
-4 TBERT 7 Series GTZ
--{F IBERT Ultrascale GTH

Copy IP...
B Open IP Example Design... -LF ILA (Inteqrated Logic Analyzer)
IP Docurmentation » +4F In System IBERT

- 4F ITAG ta AXI Master

I ke

il
{H  Report IP Skatus

¥ Remowve IP From Project, .. Delete

Set Used In... Select an IF or Interface or Reposit

B Add Existing IP...
IP Sources |

X15584-121416

Figure 2-20: Open IP Example Design
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12.1In the sources window, Design Sources should now show the IBERT design example
(Figure 2-21).

Project Manager - ibert_ultrascale_gty_0_example

Sources — O X

A= W RE

=|-{= Diesign Sources (3]

. [+i8 4 example_ibert_ultrascale_gty_0 (sxample_bert_ult
¢ E-LFu_jbert_gty_core - ibert_ultrascale_gty_0 (ibert_ultrasca

§ e Text (2

— ' Constraints (1]

i B+ constrs_1 (1]

: f5 example_ibert_ultrascale_gty 0.xdc

-+ Simulation Sources (3]

Fl T 3 @

Hierarchy | IP Sources | Libraries | Compile Order

& Sources | 3 Templates

X15585-121416
Figure 2-21: Design Sources File Hierarchy
13. Click Run Synthesis from the Flow Navigator to synthesize the design (Figure 2-11).

14. When the synthesis is done, a Synthesis Completed window opens. Select Run
Implementation and click OK (Figure 2-12).

15. When the implementation is done, an Implementation Completed window opens. Select
Generate Bitstream and click OK (Figure 2-13).

16. When the Bitstream Generation Completed dialog window appears, click Cancel
(Figure 2-14).

17. Navigate to the
... \lbert_ultrascale_gty_0_examplel\ibert_ultrascale_gty 0_exampl
e.runs\impl_1 directory to locate the generated bitstream.
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Appendix A

Warranty

THIS LIMITED WARRANTY applies solely to standard hardware development boards and standard
hardware programming cables manufactured by or on behalf of Xilinx (“Development Systems”).
Subject to the limitations herein, Xilinx warrants that Development Systems, when delivered by
Xilinx or its authorized distributor, for ninety (90) days following the delivery date, will be free from
defects in material and workmanship and will substantially conform to Xilinx publicly available
specifications for such products in effect at the time of delivery. This limited warranty excludes:
(i) engineering samples or beta versions of Development Systems (which are provided "AS IS”
without warranty); (ii) design defects or errors known as “errata”; (iii) Development Systems
procured through unauthorized third parties; and (iv) Development Systems that have been subject
to misuse, mishandling, accident, alteration, neglect, unauthorized repair or installation.
Furthermore, this limited warranty shall not apply to the use of covered products in an application
or environment that is not within Xilinx specifications or in the event of any act, error, neglect or
default of Customer. For any breach by Xilinx of this limited warranty, the exclusive remedy of
Customer and the sole liability of Xilinx shall be, at the option of Xilinx, to replace or repair the
affected products, or to refund to Customer the price of the affected products. The availability of
replacement products is subject to product discontinuation policies at Xilinx. Customer may not
return product without first obtaining a customer return material authorization (RMA) number
from Xilinx.

THE WARRANTIES SET FORTH HEREIN ARE EXCLUSIVE. XILINX DISCLAIMS ALL OTHER
WARRANTIES, WHETHER EXPRESS, IMPLIED OR STATUTORY, INCLUDING, WITHOUT LIMITATION,
ANY WARRANTY OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE, OR
NON-INFRINGEMENT, AND ANY WARRANTY THAT MAY ARISE FROM COURSE OF DEALING,
COURSE OF PERFORMANCE, OR USAGE OF TRADE. (2008.10)

Do not throw Xilinx products marked with the “crossed out wheeled bin” in the trash. Directive
2002/96/EC on waste electrical and electronic equipment (WEEE) requires the separate collection of
WEEE. Your cooperation is essential in ensuring the proper management of WEEE and the
protection of the environment and human health from potential effects arising from the presence
of hazardous substances in WEEE. Return the marked products to Xilinx for proper disposal. Further
information and instructions for free-of-charge return available at: www.xilinx.com\ehs\weee.htm.
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Appendix B

Additional Resources and Legal Notices

Xilinx Resources

For support resources such as Answers, Documentation, Downloads, and Forums, see Xilinx
Support.

Solution Centers

See the Xilinx Solution Centers for support on devices, software tools, and intellectual
property at all stages of the design cycle. Topics include design assistance, advisories, and
troubleshooting tips.

References

The most up to date information related to the VCU1287 kit and its documentation is
available on these websites.

Virtex UltraScale FPGA VCU1287 Characterization Kit

Virtex UltraScale FPGA VCU1287 Characterization Kit documentation

Virtex UltraScale FPGA VCU1287 Characterization Kit Master Answer Record (AR 66056)

These documents provide supplemental material useful with this guide:

1. VCU1287 Characterization Board User Guide (UG1121)

2. HW-CLK-101-SCLK2 SuperClock-2 Module User Guide (UG770)

3. Silicon Labs CP210x USB-to-UART Installation Guide (UG1033)

4. UltraScale Architecture Configuration User Guide (UG570)

5. Vivado Design Suite User Guide: Programming and Debugging (UG908)

6. Kintex UltraScale FPGAs Data Sheet: DC and AC Switching Characteristics (DS892)
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7. LogiCORE IP Integrated Bit Error Ratio Tester (IBERT) for 7 Series GTX Transceivers: Product
Guide for Vivado Design Suite (PG132)

8. Virtex UltraScale FPGAs Data Sheet: DC and AC Switching Characteristics (DS893)
9. Zyng-7000 All Programmable SoC Overview (DS190)

10. UltraScale Architecture GTH Transceivers User Guide (UG576)

11. Vivado Design Suite User Guide: Getting Started (UG910)

12. Tera Term Terminal Emulator Installation Guide (UG1036)

13. UltraScale FPGAs Transceivers Wizard LogiCORE IP Product Guide (PG182)

Training Resources

14. Vivado Design Suite Hands-on Introductory Workshop

15. Vivado Design Suite Tool Flow

Please Read: Important Legal Notices

The information disclosed to you hereunder (the “Materials") is provided solely for the selection and use of Xilinx products. To the
maximum extent permitted by applicable law: (1) Materials are made available "AS IS" and with all faults, Xilinx hereby DISCLAIMS
ALL WARRANTIES AND CONDITIONS, EXPRESS, IMPLIED, OR STATUTORY, INCLUDING BUT NOT LIMITED TO WARRANTIES OF
MERCHANTABILITY, NON-INFRINGEMENT, OR FITNESS FOR ANY PARTICULAR PURPOSE; and (2) Xilinx shall not be liable (whether
in contract or tort, including negligence, or under any other theory of liability) for any loss or damage of any kind or nature related
to, arising under, or in connection with, the Materials (including your use of the Materials), including for any direct, indirect, special,
incidental, or consequential loss or damage (including loss of data, profits, goodwill, or any type of loss or damage suffered as a
result of any action brought by a third party) even if such damage or loss was reasonably foreseeable or Xilinx had been advised
of the possibility of the same. Xilinx assumes no obligation to correct any errors contained in the Materials or to notify you of
updates to the Materials or to product specifications. You may not reproduce, modify, distribute, or publicly display the Materials
without prior written consent. Certain products are subject to the terms and conditions of Xilinx's limited warranty, please refer to
Xilinx's Terms of Sale which can be viewed at https://www.xilinx.com/legal.htm#tos; IP cores may be subject to warranty and
support terms contained in a license issued to you by Xilinx. Xilinx products are not designed or intended to be fail-safe or for use
in any application requiring fail-safe performance; you assume sole risk and liability for use of Xilinx products in such critical
applications, please refer to Xilinx's Terms of Sale which can be viewed at https://www.xilinx.com/legal.htm#tos.

Automotive Applications Disclaimer

AUTOMOTIVE PRODUCTS (IDENTIFIED AS “XA" IN THE PART NUMBER) ARE NOT WARRANTED FOR USE IN THE DEPLOYMENT OF
AIRBAGS OR FOR USE IN APPLICATIONS THAT AFFECT CONTROL OF A VEHICLE ("SAFETY APPLICATION") UNLESS THERE IS A
SAFETY CONCEPT OR REDUNDANCY FEATURE CONSISTENT WITH THE ISO 26262 AUTOMOTIVE SAFETY STANDARD (“SAFETY
DESIGN"). CUSTOMER SHALL, PRIOR TO USING OR DISTRIBUTING ANY SYSTEMS THAT INCORPORATE PRODUCTS, THOROUGHLY
TEST SUCH SYSTEMS FOR SAFETY PURPOSES. USE OF PRODUCTS IN A SAFETY APPLICATION WITHOUT A SAFETY DESIGN IS FULLY
AT THE RISK OF CUSTOMER, SUBJECT ONLY TO APPLICABLE LAWS AND REGULATIONS GOVERNING LIMITATIONS ON PRODUCT
LIABILITY.

© Copyright 2015-2016 Xilinx, Inc. Xilinx, the Xilinx logo, Artix, ISE, Kintex, Spartan, Virtex, Vivado, Zyng, and other designated
brands included herein are trademarks of Xilinx in the United States and other countries. All other trademarks are the property of
their respective owners.
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